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Learning Objectives

Understand how Arduino relates to IoT

Understand what a microcontroller is and it’s
general architecture

Explain the concepts of microcontroller pins as
inputs and outputs

Know what an Arduino is and how it can be used
for building and programming projects

Understand basic Electronic components and
Sernsors

Know how to setup:and program the Arduino
using a breadboard and components

The Internet of Things

We're building a world-sized robot, and we don't even
realize it. - Bruce Schneier 2016




Internet of Things IoT

Devices enabled with Machine-to-machine communications
(Sensors and Actuators)

The future will see an Internet of Things where billions of
devices are connected to each other, all sharing data via the
Internet

As sensors become a low-cost technology, it is cheaper and
cheaper to add them to any device

IoT capabilities can be added to just about any physical object
including clothing, jewelry, thermostats, medical devices,
household appliances, home automation, industrial controls,
wearable computing, even light bulbs.

Sensors & Actuators

We are giving our world a digital nervous system. Location data using GPS sensors. Eyes
and ears using cameras and microphones, along with sensory organs that can measure
everything from temperature to pressure changes.

Machine Vision / Optical »; Position / Presence / Proximity
@ Ambient Light ‘
e
(4=
Acceleration / Tilt Motion / Velocity / Displacement

a2\

Electric / Magnetic

Leaks / Levels

Force / Load / Torque
Strain / Pressure




Connectivity

These inputs are digitized and placed onto networks.
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These networked inputs can then be combined into bi-directional systems that integrate data,
people, processes and systems for better decision making.
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entities are creating new types
of smart applications and services.

By 2020 the Business Opportunity
is bigger than $1 Trillion

The Internet gave us the
opportunity to connect in
\ ways we could never have
~\\ dreamed possible.
v The Internet of Things
will take us beyond
connection to become

part of a living, moving,
global nervous system.




What is a Microcontroller

Program
Memory

-2 Microcontroller

Fig. 0-1 Microcontroller versus Microprocessor

What is the Arduino

The word “Arduino” can mean 3 things

A physical piece A programming A community
of hardware environment & philosophy
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Arduino Shields

Micro SD MP3 Trigger

Arduino vs Raspberry Pi

Raspberry Pi
Has a full operating system like a PC (Linux)
Connects to Video, Audio, Ethernet & USB
Programming more complex
Requires ~700mA power

Software based functionality like a PC

Arduino
Interacts directly with hardware (no operating system)
Uses shields for specific hardware applications
Very low power (Pico Power options) and small footprint

Hardware based applications (like Robots)




Hardware

Why use Arduino?

® Inexpensive
® Buy for less than $20.00
® assemble your own for less than that
® Cross Platform IDE (Windows, MAC, Linux)

® Open source Integrated Development Environment
(IDE)‘and extensions

Sample Specs: Arduino Uno

Microcontoller: ATmega 328

Operating Voltage 5V

Input Voltage (recommended) 7-12V

Input Voltage (limits) 6-20V

Digital 1/O Pins 14 (of which 6 provide PW M output)
Analog Input Pins 6

DC Current per I/O Pin 40 mA

DC Current for 3.3V Pin 50 mA

Flash*Memory. 32 KB (of which 0.5 KB used by bootloader)
SRAM 2 KB (ATmega328)

EEPROM 1 KB (ATmega328)

Clock Speed 16 MHz




The Arduino Microcontroller:
Atmel Atmega 168/328

Arduino function

digital pin 1 (TX)
digital pin 2

digital pin 3 (FWM)
digital pin 4

igital pin 5 (PWM)
igital pin & (PWM)
Higital pin 7
digital pin 8

(PCINT14/RESET) PC6]
(PCINT16/RXD) PDO]
(PCINT17/TXD) PD10]

(PCINT18/NTO) PD2}:

(PCINT19/0C2B/INT1) PD3 [}
(PCINT20/XCK/TO) PD4 ]
vee

GND [}
(PCINTB/XTAL1/TOSC1) PBS]
(PCINT7/XTAL2/TOSC2) PB7 ]
(PCINT21/0COBIT1) PD5 ]
(PCINT22/OCOAAING) PDE ]
(PCINT23/AIN1) PD7[]

(PCINTO/CLKONCP1) PBOC]

[1 PCS (ADCS/SCLPCINT13)
] PC4 (ADCA4/SDA/PCINT12)
1 PC3 (ADC3/PCINT11)

[ PC2 (ADC2/PCINT10)

[1 PC1 (ADC1/PCINTS)

] PCO (ADCO/PCINTS)

[ 1GND

[ AREF

] AvCC

[ PB5 (SCK/PCINTS)

[ PB4 (MISO/PCINTA4)

[ PB3 (MOSI/OC2A/PCINTA)
[] PB2 (SSIOC1BPCINTZ)

1 PB1 (OC1A/PCINT1)

Arduino function
analog input 5
analog input 4
analog input 3
analog input 2
analog input 1
analog input 0

GND

analog reference
VCC

digital pin 13

digital pin 12

digital pin 11{PWM)
digital pin 10 (FWM)
digital pin 9 (PWM)

Digital Pins 11,12 & 13 are used by the ICSP header for MOSI
MISO, SCK connactions (Atmegalss pins 17,18 & 15). Avald low-
impadance lnads on these pins when wsing the ICSP header

The Arduino Microcontroller:
Architecture

Timars/
counters

$ t 3 3

Central processing unit
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Concepts: INPUT vs. OUTPUT

Referenced from the perspective of the microcontroller

Inputs is a signal / Output is any signal exiting
information going into the the board.
board.

Examples: Buttons Switches, Examples: LEDs, DC motor,
Light Sensors, Flex Sensors, servo motor, a piezo buzzer,
Humidity Sensors, Temperature  relay,an RGB LED
Sensors...

Concepts: Analog vs. Digital

® Microcontrollers are digital devices — ON or
OFF.

® analog signals are anything that can be a full
range of values. What are some examples?

. /\/\
Digital Signal Analog Signal




Digital? Analog?
Digital has two values: on and off
Analog has many (infinite) values
Computers don’t really do analog, they quantize

Remember the 6 analog input pins---here’s how
they Work digitized point

analog

voltage . L :
signal digitized signal

)

todbot.com/blog/bionicarduino

Electricity \ Electronics Basic
Concepts

Ohms Law
Voltage
Current
Resistance
Power (Watts)

Using a Multi-meter




Ohm’s Law

Volts (V)
Potential
Energy

Current (I)
Energy Flow

Resistance (R)
Opposition to
electrical current

Ohm’s Law




Current Flow Analogy
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High Current Low Current

Voltage Analogy

More Energy == Higher.\\J/oItage Less Energy == Lower Voltage

V-I-




Resistance Analogy

Water
Tower

Big Pipe == Lower Res

Continuity — Is it a Circuit?

The word “circuit” is derived from the circle. An
Electrical Circuit must have a continuous LOOP
from Power (V..) to Ground (GIND).

Continuity is important to make sure portions of
circuits are connected. Continuity is the simplest
and possibly the most important setting on your
multi-meter.




Measuring Electricity — Voltage

Voltage is a measure of potential electrical
energy. A voltage is also called a potential
difference - it is measured between two
points in a circuit — across a device.

Measuring Electricity -- Current

Current is the measure of the rate of charge flow. For
Electrical Engineers — we consider this to be the
movement of electrons.

In order to measure this — you must break the circuit
or insert the meter in-line (series).

Q 20MQ  OFF  200m
200k )
20k

20




Measuring Electricity - Resistance

Resistance is the measure of how much opposition to
current flow is in a circuit.

Components should be removed entirely from the
circuit to measure resistance. Note the settings on
the multi-meter. Make sure that you are set for the
appropriate range.

©
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Class Kit

Here are the components of the class kit:
Arduino UNO R3 ATmega 328P-PU board-USB cable
1 - Mini Breadboard
14 - M-M jumper wires as well as M-F & 2 - Alligator Test Clips
2 - Photo Light Dependent Resistors
10 - LEDs
1 - PIR Motion Sensor Module
10 - 220 Ohm Resistors
3 - Tactile Push Button Switches
2 - 100nF Electrolytic Capacitors
2 - 2N7000 MOSFET Transistors
1 - Piezo Buzzer

1 - Sensor Trigger Drum Disc




Solderless Breadboards
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Adding control - let’s use the Arduino
and start programming!!!




Getting Started

Check out: http://arduino.cc/en/Guide/HomePage

1 = Download & install the Arduino environment
(IDE)

2. Connect the board to your computer via the UBS
cable

3 « If needed, install the drivers
4. Launch the Arduino IDE

Handling the Arduino - The Proper Way

Proper Handling - by the edges!!!



http://arduino.cc/en/Guide/HomePage

Handling the Arduino - How NOT to
Do It!

Improper Handling - NEVER!!!

Try It: Connect the USB Cable

et LED

Power LED should stay on




Arduino IDE

the documentation at http://arduine.cc
This example code is in the public domain.

modified & May 2014
by Scott Fitzgerald
*/

// the setup function runs once when you press reset or power the bo
void setup() {

// initialize digital pin 13 as an output.

pinMode (13, OUTPUT);

// the loop function runs over and over again forever

void loop ()
digitalWrite (13, HIGH):  // turn the LED on (HIGH is the voltage
delay(1e00); // wait for a second
digitalWrite (13, LOW); // turn the LED off by making the voltag
delay(1000); // wait for a second

Environment for more information

sketch_may01a | Arduino 1.0.3
File Edit Sketch Help
Auto Format Ctrl+T

Your computer
Archive Sketch communicates to the

skeich_may01 Fix Encoding & Reload

[ Eneedns o Arduino microcontroller
s , via a serial port >

Seriel Port through a USB-Serial
Programmer adapter.

Burn Bootloader

Check to make sure that
the drivers are properly
installed.



http://arduino.cc/en/Guide/Environment

Settings: Tools - Board

sketch_jun7a | Arduino 1.0.5 ATtiny85 (external 20 MHz clock)

ATtim (internal 1 MHz clock)
File Edit Sketch Help e
ATtiny44 (internal 8 MHz clock)
Auto Format Ctrl+T

ATtiny44 (external 20 MHz clock)
Archive Sketch
renive < ATtiny24 (internal 1 MHz clock)
sketch_junt 74 .
Fix Encoding & Reload o
ATtiny24 (internal & MHz clock)
Serial Monit: Chrl Shift+M
enal Moniter feonit ATtiny4 (external 20 MHz clock)
ArduBlack [» | Arduino Uno |,
Arduino Duerntfanove w/ ATmega328

Board

Arduino Diecimila or Duemilanove w/ ATmeqa168
Arduino Nano w/ ATmega328

Programmer Arduine Nano wf ATmegal68

Burn Bootloader Arduino Mega 2560 or Mega ADK

Arduino Mega (ATmega1280)

Serial Port

Arduine Leonarde

Arduino Esplora

Next, double-check that the proper board is selected under
the Tools>Board menu.

Terminology

“sketch” — a program you write to run on an
Arduino board

“pin” — an input or output connected to something.
e.g. output to an LED, input from a knob.
“digital” — value is either HIGH or LOW.
(aka on/off, one/zero) e.g. switch state
“analog” — value ranges, usually from 0-255.

e.g. LED brightness, motor speed, etc.




Using Arduino

Vold setuplo [
pirriode (ledPin, CUTFOT); A seba L

T
woid loap () {
digita lUrite]ladFin, HIGH;;
. delo (1880 );
® Write your sketch ﬂl;lzill.lr'.;e(lazpln, Lowy;
Azlo 1008 )5
}-

® Press Compile button
(to check for errors)

® Press Upload button to program
Arduino board with your sketch

upload

Try it out with the “Blink” sketch!
TX/RX flash

Load “File/Sketchbook/Examples/Digital/Blink” S
A i)

todbot.com/blog/bionicarduino g Aol sketch runs

Structure of an Arduino Program

/* Blink - turns on an LED for DELAY_ON msec,

. . s then off for DELAY_OFF msec, and repeats
An arduino program == sketch BJ Furmanrev. 1.1 Last rev: 22JAN2011

*
. /
Must have: #define LED_PIN 13 // LED on digital pin 13

#define DELAY_ON 1000

setu
| El)() \ #define DELAY_OFF 1000
oop

void setup()

setup() )
configures pin lodes and Il'initialize the digital pin as an .output:
registers G pinMode(LED_PIN, OUTPUT);
loop()

/l'loop() method runs forever,

runs the main body of th /l as long as the Arduino has power

program forever
like while(1) {...}
Where is main() ?
Arduino simplifies things
Does things for you

void loop()

digitalWrite(LED_PIN, HIGH); // set the LED on
delay(DELAY_ON); // wait for DELAY_ON msec
digitalWrite(LED_PIN, LOW); // setthe LED off
delay(DELAY_OFF); // wait for DELAY_OFF msec
}




Programming Basics

® Code is Case Sensitive

® Comments are for you — the programmer and your
friends...or anyone else human that might read
your code.

// this is for single line comments

// it's good to put a description at the top and
before anything “tricky”

/* this is for multi-line comments
Like this..
And this...

'/

BareMinimum | Arduino 1.0.5
File Edit Sketch Tools Help

BareMinimum &

/7 Mame of sketch

7/ Brief Description comments
// Date:

i

vold satup()

1
// put your getup code here, to run once:

}

void loop ()
{

// put your main code here, to run repeatedly:




This work is licensed under a Creative Comy -ShareAlike 3.0 United States License.

Three commands to know...

pinMode (pin, INPUT/OUTPUT) ;
ex: pinMode(13, OUTPUT);

digitalWrite(pin, HIGH/LOW) ;
ex: digitalWrite(13, HIGH);

delay(time_ms);
ex: delay(2500); // delay of 2.5 sec.

// NOTE: -> commands are CASE-sensitive



http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/
http://creativecommons.org/licenses/by-sa/3.0/us/

Arduino Timing

 delay(ms)

— Pauses for a few milliseconds
 delayMicroseconds(us)
— Pauses for a few microseconds

* More commands:

Programming Concepts:
Variable Types
Variable Types:

int long
unsigned int unsigned long
float



arduino.cc/en/Reference/HomePage
arduino.cc/en/Reference/HomePage
arduino.cc/en/Reference/HomePage
arduino.cc/en/Reference/HomePage

the value 1 or 0, depending on whether
P Wadeclarea the button is being pressed or not
variable as an being pressed.
integer.

int buttonState = digitalRead(pushButton);

Recall that the pushButton
- variable stores the number 2
We name it
buttonState

The value 1 or 0 will be saved in
the variable buttonState.

Programming: Conditional Statements
if()

T

[ 1
i (analogValue > threshold) { l

digitalWrite(ledPin, HIGH)}W
} l

else {

digitalWrite(ledPin, LOW);]— ' Otherwise,
do this.

@

4




Programming: Conditional Statements
if()

void loop()

{
int buttonState = digitalRead(5);
if (buttonState == LOW)
{ // do something

J

else
{ // do something else

J

Boolean Operators

<Boolean>

is equal?

is not equal?

greater than

greater than or equal
less than

less than or equal




Fading in and Fading Out
(Analog or Digital?)

® A few pins on the Arduino allow for us to

modify the output to mimic an analog
signal.

® This is done by a technique called:

- Pulse Width Modulation (PWIM)

Concepts: Analog vs. Digital

To create an analog signal, the microcontroller uses

a technique called PWM. By varying the duty cycle,
we can mimic an “average’ analog voltage.

Pulse Width Modulation (PWM)




Let’s get to coding...

® Project #1 — Turn LED on and off
¢ “Hello World” of Physical Computing

Psuedo-code — how should this work?

Turn oA : Turn » Wait = Rinse &

LED ON Wait S 1 FD OFF Repeat

Add an External LED to pin 13

* File > Examples > Digital > Blink

* LED’s have polarity

— Negative indicated by flat side of the housing
and a short leg

www.instructables.com




Project #1: Wiring Diagram

Move the green
wire from the
power bus to pin
13 (or any other
Digital I/O pin on
the Arduino
board.

Image created in Fritzing

Our First Program

Blink | Arduino 1.6.4
File Edit Sketch Tools Help

the documentation at http:/sarduino.cc
This example code 1s in the public domain.

modified 8 May 2014
by Scott Fitzgerald
*/

// the setup function runs once when you press reset or power the bo
void setup() {

J/ initialize digital pin 13 as an output.

pinMode (13, OUTPUT);

/¢ the loop function runs over and over again forever

voild Toop() {
digitalWrite (13, HIGH):;  // turn the LED on (HIGH is the voltage
delay (1000) ; // wait for a second
digitalWrite (13, LOW); /4 turn the LED off by making the voltag
delay (1000); /f wait for a second




A few simple challenges
Let’s make LED#13 blink!

— blink with a 200 ms second interval.

— Add another LED with it’s own 220 ohm
resistor. Make it blink after the first LED
blinks

— find the fastest blink that the human eye
can still detect...

® 1 ms delay? 2 ms delay? 3 ms delay???

Project #2 — Fading
Introducing a new command...

Pulse Width Modulation
0% Duty Cycle - analogWrite(0)

analogwWrite(pin, val); E

25% Duty Cycle - analogWrite(64)

pin - refers to the OUTPUT pin & |-| : I L—
(11m1ted tO d1g1tal plnS 3, 5, 6, 9, 50% Duty Cycle - analogWrite(127)
10,11.)

75% Duty Cycle - analogWrite(191)
L L |

val - 8 bit value (0 - 255). LI LI L LI L

100% Duty Cycle - analogWrite(255)
L |

0=>0V | 285=>6V j | | |




Move one of your LED pins over to
Pin 9
In Arduino, open up:
File > Examples - 0l.Basics - Fade

Fade | Arduino 1.0.5 - o

File Edit Sketch Tools Help

_

/i .
Fade

This example shows|how to fade an LED on pin 9
using the analogWrite() function.

This example code is in the public domain.

*/

Fade - Code Review

Fade | Arduino 1.0.5 = =

File Edit Sketch Tools Help

_

/i .
Fade

This example shows how to fade an LED on pin 9
uzing the analogWrite () function.

This example code is in the public domain.

*/

int led = 5; // the pin that the LED is attached to
int brightness = 0; /¢ how bright the LED is=
int fadeAmount 5; /4 how many points to fade the LED by




Fade - Code Review

// the setup routine runs once when you press reset:
void setup() {

// declare pin 9 to be an output:

pinMode (led, OUTPUT);
b

/¢ the loop routine runs over and over agailn forever:
vold Loop() {

// set the brightness of pin &:

analogirite (led, brightness);

// change the brightness for next time through the loop:
brightness = brightness + fade&mount;

// reverse the direction of the fading at the ends of the fade:
if (brightness == 0 || brightness == 255) {
fadefmount = -fadeAmount;
1
// walt for 30 milliseconds to see the dimming effect
delay (30);
B

Project# 2 -- Fading

® Challenge 2a — Change the rate of the
fading in and out. There are at least two
different ways to do this — can you figure
them out?

® Challenge 2b — Use 2 (or more) LEDs - so
that one fades in as the other one fades out.




Piezo Buzzer

If a voltage is applied across a piece of piezoelectric
material it will flex, or change dimension in one
direction.

In a piezo 'speaker, a piece of piezoelectric material is
attached to a diaphragm.

When the signal voltage from an amplifer is applied
across the piezo element, its flexure or dimensional
movement is transterred.to the diaphragm.

Example @?(g/

Write a program that plays two notes (440 & 660 Hz) tor 2UUms
and delays 1 second

» Load the PiezoBuzzer Sketch to your Arduino

* Note the shortlead on the buzzer goes to ground. If you have a
Piezo Drum Disk, it is not polarity sensitive.

e Connectthe long signal lead to Digital Pin 3

tone(speakerPin, frequency, duration); // play the tone
delay(duration); //wait for the tone to finish

Try the Piezo Tone Melody Mario Sketch




Input

Input is any signal entering an electrical system

® Both digital and analog sensors are forms of input

® Input can also take many other forms: Keyboards, a
mouse, infrared sensors, biometric sensors, or just
plain voltage from a circuit

Digital Sensors

Digital sensors are motre straight forward than Analog

No matter what the sensor there are only two settings:
On and Off

Signal is always either HIGH (On) or LOW (Off)

Voltage signal for HIGH will be a little less than 5V on
your Uno

Voltage signal for LOW will be 0V on most systems




Analog Sensors

Examples:
Sensors  |Variables
Mic soundVolume
Photoresistor lightLevel
Potentiometer dialPosition
Temp Sensor temperature
Flex Sensor bend
Accelerometer tilt/acceleration

Sensors

A device that transforms the physical quantity into electrical value.
Ex.: Light sensor transduce the light into change in voltage or
resistance.

1,0E+02

1,0E+01

1,0E+00

1,0E-01

1,0E-02

Photocurrent Ipce [mA]

1,0E-03

1,0E-04 i '
1,E+00 1,E+01 1,E+02 1,E+03 1,E+04 1,E+05 1,E+06
llluminance Ev [Ix]




Light sensors:

Device |Photo resistor| Photo diode |Photo transistor

Referenced . Everlight Everlight
part # POV P30 DTD-15 DPT-092

Not Not
Accuracy guaranteed | guaranteed £75%
Current . 26 mA
(10001ux) | Varies SHA (70 Kiux)
Range 110100 lux | 7to 50 klux | 1 k to 100 klux
Response 55 ms 6ns 15us
time

analogRead()

® Arduino uses a 10-bit A/D Converter:

® this means that you get input values from 0
to 1023

® 0V->0
¢ 5V-> 1023

® Ex:

~ int sensorValue = analogRead(A0);




Photo Resistor:

The value of the resistance depends on the incident
light density.

1 K-Ohm at light, 10 K-Ohm at darkness.

Project #3 — Analog Input




Code for Light Sensitive Resistor

Open LightResistor Sketch

Build circuit as in previous diagram
Open serial monitor to see Analog readings

int sensorReading;//gpaleg pin reading
wvoid setup()
=01
Serial.begin(9600) ;
pinMode (4, QUTPUT) ;
}
8 void loop()
9 B{
sensorReading=analogRead(0); //get gpalog reading
if (sensorReading<-)
2 8 {
digitalwrite (6,HIGH) ;
}
else digitalWrite(c,LOW) ;
Serial.println(sensorReading) ;
delay(1000);

Using Serial Communication

Method used to transfer data between two devices.

Data passes between the computer and Arduino
through the USB cable. Data is transmitted as zeros
(‘0’) and ones (‘'1’) sequentially.

10010100110 ...

Arduino dedicates Digital I/O pin # 0 to
receiving and Digital I/0 pin #1 to transmit.



Serial Monitor & analogRead()

sketch_apr02a | Arduino 1.0.3 = B
File Edit Sketch Tools Help

sketch_apr02a §

#¢ analogRead() & Serial.printi) A
£
£

int sensorValue = 0;
int sensorFin = A0;

woid setup () - . H

. Initializes the Serial
o
| T Communication
woid loop ()

{

sensorValue = analogRead (A0); 9600 baud data rate

Serial.println(sensorValue);
delay(l00); /7 walts by ahouw A i
) prints data to serial bus

Serial Monitor & analogRead()

sketch_apr02a | Arduino 1.0.3 = B
File Edit Sketch Tools Help Opens up a
< Serial Terminal
sketch_apri2a § W|nd0W
A# analogRead(] & SJerial.print() ~
i
£

int sensorValue = 0;
int sensorFin = A0;

woid setup()
1
Serial.begin(9600)
pinMode (A0, INPUT):
}

woid loop ()

1
sensorValue = analogRead(&0) ;
Serial.println(sensorvValue) ;
delay(l00); // waits by about 0.1 sec

¥



Additional Serial Communication
Sending a Message

void loop ( )

{
Serial.print(“Hands on “) ;
Serial.print(“Learning ") ;
Serial.println(“is Fun!!!”) ;

4/
’»\‘%ﬂfﬁ PIR Motion Sensor

Detects levels of infrared radiation. (Everything emits radiation)
The sensor is split in two halves and detects change in motion
The two halves are wired up so that they cancel each other out.

If one half sees more or less IR radiation than the other, the output will
swing high or low.




Using PIR motion sensors

Ty O PIR Sensor
- IHGITAL o=

il - e

] r/ \\

Arduino

0 | |

—— G | |

W

. b y

- d=mnge MM - g
o, Barer

PIR Motion Sensor Alarm Example

intledPin = 13;

int inputPin = 2;
sensor)

int pirState = LOW;
detected

int val = 0;

int pinSpeaker = 10;

// choose the pin for the LED
// choose the input pin (for PIR

// we start, assuming no motion
// variable for reading the pin status

//Set up a speaker on a PWM pin
(digital 9,10,0r 11)




PIR Motion Sensor Alarm
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o CB\Q) Sensor Trigger Drum Disc

The Piezo Sensor is Pressure Sensitive

* A piezo is a thin metal disc with a hard, ceramic material in the
center.

* As a high-impedance, passive transducer, it converts mechanical
energy to electrical energy.

e Crystals and certain ceramic materials generate an electrical
signal when stress is applied.




Sensor Trigger Drum Disc Example

® Work out the breadboard from the pin definitions
below
® and circuit diagram
Use Alligator clips with jumpers
Open serial window to see Analog readings
Note the 1M resistor on the sensor positive lead

Push sensor disk like a button to deform crystal & toggle LED

constintledPin= 13; //led connected to digital pinl3
const int knockSensor =“A0;// the piezo is connected to analog pin 0
const int threshold = 100; // threshold=«zalue to decide when the

detected sound is‘a‘knock or not

Knock Sensor Circuit

Note: 1M resistor from
GND to AO
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Recommended Books

Make AVR Programming (Elliot Williams) Great Book!!
Getting Started with Arduino 2™ Edition

Make an Arduino Controlled Robot

TinyAVR Microsontroller Projects for the Evil Genius
Learn Electronics with Arduino

ProgrammingYour Home (Mike Riley)

Arduino Cookbook

Arduino Robotics

Arduino Bots and Gadgets
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Questions?

Arduino Workshop

Robin C. Moseley
President & CEO
Great Lakes IT, Inc
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